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Lesson 1: Musical elements and ideas

 

In this lesson you are going to explore some of the elements that make up a piece of music, 
and create an arrangement using some pre-recorded ideas.

 

Task 1: Listening and exploring sounds

 

Open the song file “Lesson 1a” and find the sequencer.

 

a.

 

Start the sequencer, listen to the music and think about the following:

 

• How would you describe the structure or form of this music? (You could use letters such as A 
or B to note when a section repeats or when there is a contrasting section.) Is there an intro? 
How does the song end?

• What happens to the music if you change the tempo? 
Which tempo do you prefer and why? 

• Find two sections where contrasting sounds and textures have been used. Which of these 
sections do you prefer and why?

• Which track do you think is the melody or lead line? Which track contains some chords (or 
harmonies)?

• Do any sounds seem to change position during the song? How would you describe the 
change(s)?

• Do you think this song was difficult or easy to create? Say why you think this is.

 

b.

 

Select the sequencer track that you think is the melody, or lead line. Find the device that 
plays the actual sound.

 

c.

 

On that device, select a different sound to play the melody. 
Which sound do you prefer and why?

 

d.

 

Select a different sequencer track and explore some alternative sounds for this.

 

Task 2: Arranging

 

Open the song file “Lesson 1b” and find the sequencer.

You are going to create a song arrangement by moving and copying the provided material. 
Try to include an intro, a main idea, some variation on the main idea and an ending.

Here are some ideas for getting started:

 

a.

 

Listen to all the tracks together, then listen to each track separately to explore the 
material.

 

b.

 

Try out different tempo settings until you find one that you think fits the style of the music. 

 

c.

 

What material could you use to make an intro?

 

d.

 

If you repeat the first or second ideas, try to vary the repeats by using different sound 
combinations.

 

e.

 

Think about how you can make an ending.

! Use your “How to…” 
guide to help you play 
and arrange your 
music.

Check out:
• How to play your 

song.
• How to play from a 

particular song posi-
tion.

Check out:
• How to change tempo.

Check out: 
• How to mute a track.
• How to solo a track.

Check out: 
• How to find out which 

device is playing your 
sequencer track.

• How to load different 
sounds.

Check out: 
• How to move or copy 

material.
• How to erase/delete 

material.

! Save your work 
regularly!
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“How to…” student guide

 

How to play your song

 

D

 

Click the PLAY button (

 

1

 

) on the Transport Panel. 
To stop playback, click the STOP button (

 

2

 

) on the Transport Panel.

 

How to play from a particular song position

 

D

 

Drag the Song Position (P marker) with the mouse to the required position. 

 

How to change tempo

 

D

 

Click on the up/down arrows to the right of the Tempo box (

 

1

 

) on the Transport Panel. 
(Holding down the mouse button makes the values change faster.)

 

How to mute a track

 

D

 

Click in the M column (

 

1

 

) of the track you want to mute. This silences the track. A red 
cross shows that the track is muted. To cancel the mute, click on the red cross.

 

How to solo a track

 

D

 

Hold down the Alt key (Windows) or the Alt/Option key (Mac), then click in the M col-
umn of the track you want to hear by itself. All the other tracks will be muted. To cancel 
the “solo”, hold down the Alt/Option key and click again in the M column of the soloed 
track.

 

How to find out which device is playing your sequencer track

 

D

 

Select your sequencer track by clicking on the track name.

The device playing the actual sounds will jump into view in the rack immediately above 
the sequencer.

12! Tip: To quickly 
alternate between 
Play and Stop you 
can also press the 
computer’s spacebar. 
If your computer has 
a numerical keypad, 
you can also press [0] 
for stop and [Enter] 
for play.

1

1

! You will notice that the 
device has the same 
name as the 
sequencer track.
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How to load different sounds

 

1

 

Click the folder button on the front panel of the device whose sounds you want to 
change.

 

2

 

In the Patch Browser that appears, click the “Find All ReFills” icon.
This will display the Reason Factory Sound Bank.

 

3

 

Open the Sound Bank and select the folder containing sounds for your chosen device. 

 

4

 

This folder contains several more folders of patches, samples or loops. Select one of 
these folders and open it.

 

5

 

Select the individual sound you require.

 

6

 

Double-click on the sound to load it, or click Open.

 

D

 

After loading a sound, you can click the up and down arrow buttons on the device panel 
to move between sounds in the same folder, without going back into the Patch Browser.

 

How to move or copy material 

 

1

 

Select the material you want to move by clicking on it with the mouse. 

 

2

 

Hold down the mouse button and drag to the required position. 

 

D

 

To copy material hold down the mouse button and at the same time, press the com-
puter’s Ctrl Key (Windows) / Option (Alt) key (Mac). Drag the mouse and you will find 
that a copy of the material is being moved. 

 

3

 

When you have reached the required start position for the new or moved material, re-
lease the mouse button.

 

How to erase/delete material 

 

1

 

Click on the eraser icon at the top of the sequencer window. Your mouse pointer turns 
into an eraser. 

 

2

 

Click on the material you want to delete. When you’ve finished, click on the arrow tool to 
cancel the eraser. 

 

D

 

If you delete something by mistake, you can Undo it by selecting Undo Delete from the 
Edit menu.

! In some cases you can 
preview the sounds 
before actually loading 
them into the device.
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Additional “How to…” tips

 

Here are some extra tips to help you work more easily over the coming weeks:

 

How to detach the sequencer window 

 

To detach the sequencer from the rack, click the button with the arrow at the top right cor-
ner of the rack. (You can also do this by selecting “Detach Sequencer Window” from the 
Windows menu.)

To attach the sequencer window again, click on the icon at the top right of the window, (just 
above the magnifying glass icons).

 

How to loop a section 

 

This is handy if you want to hear a few bars over and over while working.

 

1

 

Click the Loop button on the Transport Panel. 

 

2

 

Click on the L and R flags (called Left and Right Locators) at the top of the sequencer 
window, hold down the mouse button and drag these to the positions in the song where 
you want your loop to start and end.

 

How to expand your sequencer view

 

You can expand or shrink the sequencer view by clicking on the + or – magnifying glass 
icons at the bottom and sides of the window, or dragging the slider with the mouse.

 

How to change the name of a sequencer track

 

You may want to give your sequencer tracks new names to fit the type of music you are cre-
ating.

 

1

 

Double-click with the mouse on the name of the track - a box will appear. 

 

2

 

Press the Backspace key to delete the track name and type in a name of your own. Press 
Return.

! When you change the 
name of a sequencer 
track, the name on the 
device playing the 
track automatically 
changes as well.
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Lesson 2: An introduction to mixing

 

In this lesson, you are going to do some mixing. Some material has already been recorded 
and you can explore ways of making it sound more interesting by adjusting the levels, tone, 
position and depth of the different sounds.

 

Task 1: Exploring the mixer 

 

Open the song file “Lesson 2a”, start the sequencer playing and explore the mixer controls 
as follows:

 

a.

 

Move the faders up or down to adjust the volume levels of the different sounds until you 
think they are correctly balanced.

 

b.

 

Find the Drums channel, and click the M button. What happens? 
Find the Bass channel and click the S button. What happens? 

 

c.

 

Move the Pan control on the Drums channel.

 

• What happens to the drum sound as the control moves? Do you think the drums sound best 
when positioned to the left, to the right or in the middle? Why is this?

 

d.

 

“Solo” the Lead Guitar channel and click the EQ button. 

 

• Move the Treble and Bass controls to the left and to the right. How could you describe the 
changes to the sound?

• Adjust the Treble and Bass controls until you have an EQ setting that you like.
• Now listen to the guitar together with the other channels. Can you still hear the guitar clearly, or 

is it perhaps a bit “muffled”, or maybe even too “bright”? Adjust the controls until you think the 
guitar blends with the other sounds.

 

e.

 

“Solo” the Drums channel, and find the Aux controls. Slowly move Aux 1 a few degrees.

 

• What happens to the drum sound? 
• Does the drum kit sound as if it’s in i) a large hall, or ii) a medium sized room? Why do you think 

this is? Listen to the drums together with the other channels.

 

f.

 

Look underneath the mixer and find the reverb unit. Click the up/down arrows on the 
front panel. 

 

• How does this change the general sound of the music? Which type of reverb do you think 
sounds best and why?

 

g.

 

“Solo” the Guitar 2 channel. Move the Aux 2 control to about half way.

 

• How would you describe the effect that has been added to this sound?

 

h.

 

Now listen to the music all the way through. Is there anything else you want to adjust in 
the mix?

! Use your “How to…” 
guide to help you 
explore the mixer 
controls and create 
your mix.

Check out:
• How to find out which 

sequencer track corre-
sponds with which 
mixer channel.

• How to adjust the 
mixer faders.

Check out:
• How to mute and solo 

channels.

Check out:
• How to adjust the Pan 

and Aux controls.

Check out:
• How to activate and 

adjust the EQ.

Check out:
• How to change set-

tings on the reverb 
unit.
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Task 2: Creating a mix 

 

Open the song file “Lesson 2b”. 

Listen to the music and create your own mix. Here are some ideas for getting started:

 

a.

 

Balance the volume levels of the different sounds. 
(You may need to re-adjust these as you add effects or EQ.)

 

b.

 

Adjust the EQ (treble/bass) of individual sounds so that they are heard more clearly.

 

c.

 

Use the Pan controls to place certain sounds to the right or left of the mix. 

 

d.

 

Using the Aux 1 and 2 controls, add reverb or delay (echo) to some of the sounds. 
Which tracks sound best with effects added? Why do you think this is? 

What do you think of your final mix? 

Is there anything you might do differently another time? 

Check out: 
• How to scroll up or 

down in the rack.

! Save your work 
regularly!
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“How to…” student guide 

 

How to find out which sequencer track corresponds with which mixer channel

 

How to adjust the mixer faders

 

D

 

To move a fader (

 

1

 

), click on it, hold down the mouse button and drag up or down.

 

How to mute and solo channels

 

D

 

Click on the M button (

 

2

 

) to mute the channel. This silences the channel.

 

D

 

Click on the S button (

 

3

 

) to solo the channel. This lets you hear the channel by itself.

 

D

 

To return to the full mix, click the button again to cancel the mute or solo.

 

How to adjust the Pan and Aux controls

 

D

 

Click on the control (Pan = 

 

4

 

, Aux = 

 

5

 

) and hold down the mouse button. Drag the con-
trol downwards to move it to the left and upwards to move it to the right.

 

How to activate and adjust the EQ

 

D

 

Click the EQ button (6). When it turns red, EQ is activated.
Adjust the EQ settings for each channel using the Treble and Bass rotary controls. Turn-
ing a control to the left “cuts” or removes some treble or bass frequencies from the 
sound. Turning a control to the right “boosts” treble or bass frequencies. 

How to change settings on the reverb unit

Click on the up/down arrows to the right of the display. This lets you change the reverb type.

How to scroll up or down in the rack

You might need to do this if you decide to change sounds in a device and then need to go 
back to the mixer again.

D Click on the scroll bar to the right of the rack, hold down the mouse button and move up 
or down until you find the required device.

D You can also move around in the rack by clicking on the up/down arrows at the bottom 
right of the rack.

! If you change the 
name of a sequencer 
track, you will find that 
the names of the 
corresponding sound 
device and its mixer 
channel automatically 
change as well.

Every sequencer track (1) containing note 
information is linked (via a sound device) to a 
mixer channel (2). 
The sequencer track and the mixer channel both 
have the same name, so it is easy to find which 
mixer channel controls you need to use when 
adjusting the sound of a particular sequencer 
track.1

2

6

2 3

1

5

4
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Lesson 3: Working with rhythm patterns and 
phrases

In this lesson you are going to add a drum track to a song. Some drum patterns have been 
provided as a starting point. 

Open the song file “Lesson 3” and find Redrum.

Task 1: Playing and changing patterns 

a. Try out the different sounds that make up the drum kit.

b. Click RUN and listen to the patterns you've been given (click pattern buttons 1-8, bank 
A).

c. What happens when you click the Shuffle switch on Redrum? 
Play some of the patterns again. How would you describe the difference? Do you prefer 
any particular patterns and why?

d. Start the main sequencer and change drum patterns as the music plays.
• Which patterns could fit with the main musical ideas in 2-, 4- or 8-bar rhythmic phrases?
• Which patterns are similar, but have a slight rhythmic change? 
• Which patterns could be used as whole or half bar “fills” at the end of a phrase?

Task 2: Recording drum patterns and editing rhythmic phrases
Record some patterns onto the sequencer track called “Drums”. Think about how they fit 
musically with the other material.

a. Aim to record 4 or 8 bars of patterns and changes at a time.

b. Listen for different song sections. Perhaps use a drum fill at the end of a phrase that 
leads into a new section or idea.

c. Drums and bass work together as a “team” in many styles of music. Try soloing the bass 
to hear the length and style of its phrases. Now try and match your drum pattern repeats, 
changes and phrase lengths to those of the bass.

d. Did you click the wrong pattern by mistake during recording? Try editing the playback 
order of your recorded patterns in the Pattern lane.

e. The drums could perhaps drop out at some point for a change. Try inserting an empty 
pattern in the Pattern lane to cover the number of bars in which the drums don’t play.

! Use your “How to...” 
guide to help you play, 
record and edit your 
patterns.

Check out: 
• How to audition Re-

drum sounds.

Check out: 
• How to change drum 

patterns.

Check out: 
• How to add Shuffle to 

drum patterns.

Check out:
• How to set up and 

record from the start 
of a track.

• How to record from a 
different place on the 
track.

Check out:
• How to edit pattern 

change information.
• How to insert silence 

using empty patterns.

! Save your work 
regularly!
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“How to…” student guide

How to set up and record from the start of a track

1 Select the sequencer track you want to record on, and click the “In” column (1) so that 
the MIDI icon appears.

2 Make sure that the Song Position marker (2) is set to the start.

3 You may find it useful to set the Left and Right Locators (3) as start and end boundaries 
– this will help you see where to stop recording.

4  Click the Record button (4) on the Transport Panel...

5 ...then click Play (5).

6 When you’ve finished recording, click the Stop button (6).

This is what you can expect to see on your Drums track when you’ve recorded some different patterns. 
It is information about the different pattern changes you’ve made.

• How to change drum 
patterns: Click on the pat-
tern number buttons 1-8 
(2) to change pattern. 

• How to audition Redrum 
sounds: Click on the ar-
row button (1) at the top of 
each sound channel.

• How to add Shuffle to 
drum patterns: Click the 
Shuffle switch (3) on Re-
drum. To alter the amount 
of shuffle applied to the 
rhythm, adjust the Pattern 
Shuffle control (4) on the 
Transport Panel.

1

2 3

4

1
2 3

6 5 4
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How to record from a different place on the track

Set up as before, but move the Song Position marker (1) to the place where you want to 
start recording this time. Click Record, then Play. When you’ve finished recording, click the 
Stop button.

How to edit pattern change information

After recording your patterns, you may decide to change the playback order, or replace one 
pattern with another.

1 Select the track on which you’ve just recorded the drum patterns (1). 

2 Switch to Edit view by clicking the icon in the top left corner of the sequencer window 
(2). 

3 Click on the Pattern icon (3) to display the Pattern lane. This shows which particular pat-
terns you recorded in what order.

4 Select the pencil tool (4).

5 From the Pattern drop-down menu (in the top left of the lane - 5) select the pattern num-
ber you want to use. 

6 Now “draw in” that pattern change at the required position. If you want the new pattern 
to play for several bars, keep the mouse button pressed and drag to the right. Should 
you drag too far, select “Undo Draw Events” from the Edit menu and try again.

How to insert silence using empty patterns 

If you do not want the drums to play at some point in your song, you can insert an empty pat-
tern - a pattern that contains no notes.

1 Open the Pattern lane and select the pencil tool. 

2 From the Pattern drop-down menu, select a Redrum pattern that you know is empty, for 
example D8. 

3 Now “draw in” the new pattern at the required place. When the sequencer starts you 
should not hear any drum sounds, because the pattern being “played” is empty.

1

1

2 3 4

5

! Note: Editing pattern 
positions is normally 
affected by the snap 
value set in the 
sequencer drop-down 
menu. A “Bar” snap 
value means that 
pattern changes can 
only be edited to start 
at the beginning of a 
bar. A “1/2” snap 
value will allow you to 
draw in changes at 
half bars etc.

6
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Lesson 4: Your first original song! – Creating 
the drum track

It’s time to start working on your first original song! In this lesson you are going to create 
some rhythm patterns that can form a drum track for the song.

Open the song file “Lesson 4” and start the sequencer.

A loop has been provided on one of the tracks. You could use this as an idea for getting 
started. What kind of drum sounds and rhythms might fit the style of this loop? 

Now find Redrum and try out the following:

Task 1: Setting up your drum kit and creating a pattern

a. Explore some sounds. 
• Choose a drum kit that you think suits the type of music you are going to create.
• Audition the individual kit sounds. If you don’t like some of these sounds, try changing them.

b. Record some pattern steps.
• Start building your pattern by selecting a drum sound channel and clicking on some steps. 
• Now select different drum sound channels and add more notes until your pattern is complete.

c. Add some dynamics and “feel”.
• Add dynamics to some individual pattern notes. 
• Try adding Shuffle to the pattern for some extra “feel”.

d. Experiment with tempo.
• Try changing the tempo on the Transport Panel. What do you notice when you play the pattern 

you just created? Which tempo do you prefer and why?

Task 2: Developing patterns and pattern variations
Now create some more patterns that you can alternate or combine with your Task 1 pattern 
to form phrases and song sections. Try some of the following:

a. Copy your Task 1 pattern to one or two other empty locations. 

b. Create pattern “variations” by adding or removing notes in the pattern copies. 

c. Create one or two “fill” patterns to use at the end of a phrase, or to lead from one song 
section into another. For example, you could make a 1-bar fill pattern, or build a simpler 
fill into steps 9-16 of a Task 1 pattern copy. 

d. Create a “random” pattern, or try randomly altering an existing pattern.

! Use your “How to…” 
guide to help you 
create your patterns.

Check out:
• How to load a drum kit 

and change sounds.

Check out:
• How to create a 

pattern.

Check out:
• How to add step 

dynamics.

Check out:
• How to copy a pattern.

Check out:
• How to create a “ran-

dom” pattern.
• How to randomly alter 

an existing pattern.

! Save your work 
regularly!
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If you have some time left, try this…

Recording and Arranging Patterns
Try recording some of your patterns onto the sequencer track named “Redrum”. You could 
perhaps give the track a new name that reflects the style of your music!

a. Aim to record about 16 bars altogether. (You might want to record 4 or 8 bars of pat-
terns and changes at a time.)

b. If you need to, you can change the playback order of the recorded patterns in the Pattern 
lane.
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“How to…” student guide

How to load a drum kit and change sounds

The first step in creating a new pattern is to select an appropriate set of drum sounds.

D Click on the folder button in the Patch Select section (1). This will take you to the Patch 
Browser, where you can check out the different category folders of Redrum kits, and se-
lect a kit from one of these folders (2).

D Clicking the up/down arrows (3) lets you load other kits in the same category folder.

D To change individual sounds in the drum kit, click on the up/down arrows at the top of 
the sound channels (4). 

D If any new sounds are too loud or too soft, you can adjust the Level control (5) on the ap-
propriate sound channels.

How to create a pattern

1 Select a location for creating your new pattern (1).

2 Choose a drum sound by clicking the “Select” button (2) on the appropriate sound 
channel.

The marked pattern steps show the actual quarter and eighth note beats in the bar.

3 Click RUN (3) to start the pattern sequencer.

4 Click each pattern step (4) on which you want to add a note for that particular sound. 

5 Select a new sound channel and add more notes for that drum sound. 

6 Continue like this until your pattern is complete.

D If you enter a note by mistake simply click on that note to remove it.

4

3

5

1

2

! If you forget how to 
load sounds, check 
out the “How to...” 
pages for Lesson 1. 

2

1 + 2 + 3 + 4 +

1

3 4

! As the sequencer 
cycles through the 
steps, you will hear the 
notes you have added.
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How to add step dynamics

1 Set the dynamic switch (1) to hard, medium, or soft. 

2 Click on a pattern step (2) to enter a note with the selected dynamic. Different colors in-
dicate which notes have hard, medium or soft dynamics.

How to copy a pattern

1 Select the pattern you want to copy.

2 From the Edit menu select “Copy Pattern”. 

3 Select a new location for the pattern copy, and select “Paste Pattern” from the Edit 
menu. (Use the copy/paste keys on your computer keyboard if you prefer.)

D To clear a pattern, select “Clear Pattern” from the Edit menu.

How to create a “random” pattern

1 Select an empty pattern location. 

2 Choose “Randomize Pattern” from the Edit menu and an instant pattern will be created 
there.

How to randomly alter an existing pattern

It is best to start by making a copy of the pattern you want to alter, (see above). 

D Click on the pattern copy to select it. Choose “Alter Pattern” from the Edit menu and that 
pattern will change!

1
2

! If you have already 
entered a note and 
want to change the 
dynamic, select a new 
dynamic and click 
again on the step. The 
color and the dynamic 
level will change.
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Lesson 5: Your first original song! – Building a 
bass line

In this lesson you are going to create a bass line to go with the drum track of your song.

Task 1: Exploring bass patterns
First you are going to explore some “ready-made” bass patterns. These might give you some 
ideas when you come to create your own.

Open the song file “Lesson 5” and find the Matrix pattern sequencer.

Take a few minutes to explore some of the following:

a. Click RUN on the Matrix and listen to the bass patterns by clicking pattern buttons 1-4. 

b. Now start the sequencer and listen to these patterns against the drum track.

c. Change the sound used to play the patterns. 
Where does the sound actually come from?

d. Select a pattern and try changing one or two of the note pitches. 

e. Now adjust some of the note velocities (volume), and try changing one or two of the note 
lengths. 

f. Make a copy of one of the patterns and transpose it.
Does transposing alter the pitch or rhythm?

g. Create a “random” pattern, or select a pattern and randomly alter it.

h. Click the Matrix Shuffle button and make the “feel” of the bass pattern match that of the 
drums.

Task 2: Creating and recording bass patterns 
Now open your own version of the “Lesson 4” song file and create a bass track for your 
song. 

a. Using the Matrix pattern sequencer, create some bass patterns to match the style of 
your drum track. (Use some ideas from Task 1.)

b. If you didn’t have time to record your drum track in the previous lesson, first record some 
of your drum patterns onto the “Redrum” sequencer track. Then start work on your bass 
patterns.

c. Now record some of your bass patterns onto the sequencer track named Matrix. Try and 
match the bass pattern changes and phrasing with those of your drum material. Remem-
ber, you can edit pattern changes after recording.

! Use your “How to…” 
guide to help you 
explore patterns and 
create your new bass 
line.

Check out:
• How to change a pat-

tern’s sound.

Check out:
• How to enter/change 

Matrix note pitches.

Check out:
• How to adjust note ve-

locities and lengths.

Check out:
• How to copy a pattern.
• How to transpose a 

pattern.

Check out:
• How to create a “ran-

dom” pattern.
• How to randomly alter 

an existing pattern.

Check out:
• How to enter/change 

Matrix note pitches.
• How to enter new pat-

tern notes.

! Save your work 
regularly!
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If you have some time left, try this …

Converting pattern information to notes
So far you have been able to change the order in which your recorded patterns play. 
But what if you just want to make changes to some of the notes in some of the patterns? 
You can change individual notes in patterns but this will affect all pattern repeats, and this 
may not be what you want. 

Instead of having pattern information on your sequencer track, you can have notes! This will 
let you make more detailed changes to individual notes in your drum and bass tracks.

a. Try converting the pattern information on your drum and bass tracks to notes!

b. Start the sequencer and listen to your converted tracks.
Why do you think the bass isn’t playing? 
What can you do to correct this?

c. Check out the sequencer’s Edit view. 
You’ll see all kinds of interesting information about your drum and bass track notes!

Check out:
• How to convert a pat-

tern track to notes.

Check out:
• How to play back con-

verted Matrix patterns.

Check out:
• How to open the se-

quencer’s Edit view.
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“How to…” student guide

How to change a pattern’s sound

The sounds you hear when playing Matrix patterns don’t actually come from the Matrix de-
vice. Instead, they come from whichever sound device is connected to the Matrix. Here, the 
Matrix is connected to the Subtractor 2 synth. To change the sound of the pattern, load a 
new patch into Subtractor 2.

How to enter/change Matrix note pitches 

Note pitches are already entered on each step at the pitch C3 in the upper section of the 
Matrix display (1). 

D Simply select and drag these pitches with the mouse to the required pitch positions. To 
help you, there is a piano keyboard (2) to the left of the display.

How to enter new pattern notes

D Click the step spaces in the lower section of the display (1) to enter note on/off informa-
tion. This allows the note pitches you have selected in the upper display section to play. 

How to adjust note velocities and lengths

1 To adjust the note velocity (volume), click on the step you have just entered (1), hold 
down the mouse button and drag up or down with the mouse to the required level.

2 To adjust the length of a note, click the “Tie” button to the left of the display (2). In the 
lower display section click on the step to be lengthened, hold down the mouse button 
and drag sideways until you are happy with the result. 
This ties several steps together, creating one long note.

3 You also need to make sure that the pitch is the same over the entire note. Click on the 
note pitch, hold down the mouse button and drag sideways until the note pitch and 
length cover the same number of steps.

1

2

1

12
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How to copy a pattern

1 Select the pattern to be copied.

2 From the Edit menu select “Copy Pattern”. 

3 Now select a new location for the pattern copy, and select “Paste Pattern” from the Edit 
menu. (Use the copy/paste keys on your computer keyboard instead if you prefer.) 

D To clear a pattern, select “Clear Pattern” from the Edit menu.

How to transpose a pattern

1 Select the pattern you want to transpose by clicking on it.

2 Select either “Shift Pattern Up” or “Shift Pattern Down” from the Edit menu to transpose 
your pattern up or down one semitone. 
The pattern will move one semitone up or down, depending on what you have selected.

3 Repeat this process to transpose the pattern further.

How to create a “random” pattern

Select an empty pattern location. Choose “Randomize Pattern” from the Edit menu and an 
instant pattern will be created there.

How to randomly alter an existing pattern

It is best to start by making a copy of the pattern you want to alter, (see above). 

Now click on the pattern copy to select it. 

Choose “Alter Pattern” from the Edit menu and that pattern will change!

Original pattern Transposed pattern
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Additional “How to…” tips

How to convert a pattern track to notes

1 Scroll right to the end of the sequencer track you plan to convert and find the E (ending) 
marker. Drag this marker back to the end of the last bar of your song. 

2 Select the sequencer track by clicking on the track name, then select “Convert Pattern 
Track to Notes” from the Edit menu. 

You will see the individual note information on the track. This will normally be displayed 
as 1-bar blocks or “groups”, corresponding with the individual pattern lengths. These 
show where the same pattern has been repeated (same color used) and where a pattern 
change has happened (the color changes).

How to play back converted Matrix pattern information

To do this you need to move the new note material from the Matrix track to the empty Sub-
tractor 2 track. 

1 Select the material on the Matrix track. To do this click in a space near the material, hold 
down the mouse button, drag a frame around the material then release the button. The 
material will change color when selected.

2 Now click again on the selected material, hold down the mouse button and drag the ma-
terial up or down to your selected track. When it is correctly positioned on the new track, 
release the mouse button. 

How to open the sequencer’s Edit view

1 Select the track you want to view, then click on the button at the top left of the se-
quencer window (1). 
This takes you to the Edit view, where you will see lanes containing different types of in-
formation about the individual notes that make up the patterns. 

2 You can choose which lanes to view by clicking on the icons (2).

1

2
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How to copy a pattern to a track

When you have converted pattern change information to notes, you can no longer use the 
Pattern lane to change the playback order of the patterns. But if you decide to make 
changes to your drum or bass track, you can delete the patterns you don’t want and add 
new ones in their place.

First you need to turn the Redrum or Matrix pattern sequencer back on again. This is be-
cause when you select “Convert Pattern Track to Notes” it is automatically turned off. To be 
able to audition other Matrix or Redrum patterns, you need to do the following:

D On Redrum, click the “Enable Pattern Section” and “Pattern” buttons so that they both 
are lit.

D On Matrix, click the “Pattern” button so that it lights up.

Now you can go on auditioning and adding new patterns directly to the track:

1 Select the track on which you want to have the new pattern(s). 

2 On your selected track, delete the unwanted material.

3 Drag the Left and Right Locators to set the start and end positions for the new pattern 
material.

4 Select your new Redrum or Matrix pattern by clicking the appropriate pattern button on 
the device.

5 From the Edit menu select “Copy Pattern to Track”. Your new material will appear be-
tween the Locators.

You can also use this idea to build up complete drum or bass tracks, using patterns you 
have created in Redrum or Matrix. 

! Note: When copying Matrix patterns to tracks, instead of copying the material to the 
Matrix sequencer track, copy it to the track connected to the device that plays the actual 
sounds e.g. Subtractor 2.
A dialog may appear warning you that this track is connected to another device. If this 
happens, click OK to continue.

6 When you are finished, remember to turn the pattern sequencers in Matrix or Redrum 
back off again:

D On Redrum, click the “Enable Pattern Section” and “Pattern” buttons so that they both 
turn white.

D On Matrix, click the “Pattern” button so that it goes out.
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Lesson 6: Your first original song! – Lead lines 
and harmonies 

Your new song now needs a lead line and some harmonies. In this lesson, you are going to 
use a MIDI keyboard to help you record some ideas. 

Open the file containing your own song and play the tracks you’ve recorded so far.

Task 1: Improvising and recording 

a. Using your MIDI keyboard, start by playing around with some ideas.
• Explore some sounds on the NN19 sample players and the Subtractor 1 synth.
• Which sounds might be good to use for i) lead lines, ii) harmonies or “pads”? Why?
• What will you try to record first, a lead line, or some harmonies? 

Why have you chosen to do this?

b. Is the music playing too fast for you to keep up? 
• Try changing the tempo to make it slower.
• Use the “Click” to help you play in time.

c. Now try recording something. 
• Before you start, click on the “Quantize Notes During Recording” button.
• If you want to record chords or a “layered” part, try looping a few bars and “overdubbing”.

d. Listen to your recording. What do you think of the result?
• Does the rhythm sound uneven anywhere?
• Have you played any wrong notes?
• Are any individual notes too loud or too soft?
• Do you want to delete your recording and try again? 

Task 2: Making rhythmic adjustments and recording more ideas 

a. Does your Task 1 recording still sound a bit out of time in places? 
Try quantizing the track. What happens to some of the notes on the track as you click the 
“Quantize Notes” button?

b. Record some more ideas on other tracks. Each track can be recorded in small sections. 
Try to think in “phrases” or chord sequences.

c. Group your recorded notes on each track into 2- or 4-bar phrases – this will help when 
you come to do some arranging.

d. Try changing the sounds on some of your new tracks. 
Which sounds do you prefer and why?

! Use your “How to…” 
guide to help you 
improvise and record.

Check out:
• How to explore 

sounds using your 
MIDI keyboard.

Check out:
• How to prepare for im-

provising.

Check out:
• How to prepare for re-

cording.
• How to quantize notes 

during recording.

Check out:
• How to delete re-

corded material.

Check out:
• How to quantize notes 

after recording.

Check out:
• How to record from 

different places on the 
track.

Check out:
• How to create a 

group.
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Lesson 6 – “How to…” student guide

How to explore sounds using your MIDI keyboard

1 Select the sequencer track connected to the device whose sounds you want to hear.

2 Click the “In” column on the track so that a MIDI icon appears.

3 Play your keyboard and you should hear the sound.

How to prepare for improvising

1 If you want to work on a few bars at a time, set up a Loop by dragging the Left and Right 
Locators to the required places to set the start and end points. 

2 Click the Loop button on the Transport Panel to activate looping.

3 If you can’t keep up with the music when playing, try slowing down the tempo.

How to prepare for recording

1 Select the sequencer track on which you want to record, and click the “In” column so 
that the MIDI icon appears. 

2 Set the Song Position marker to the place where you want to start recording, and acti-
vate the “Click” button (1). (If you want to have a couple of bars “count in”, set the 
marker to the start of the required count in bars.)

3 Adjust the tempo (2) so that you can record at a comfortable speed. (Return the tempo 
to its original setting when you come to play back your recording.)

4 If you want to record a part with chords, or several “layers”:
• Set the Left and Right Locators to the required start and end positions and activate the Loop 

button. 
• Check that the Overdub/Replace switch (3) is set to “Overdub”. 
• Click Record, Play and add more material each time the looped bars repeat.

How to quantize notes during recording

This will correct the timing of notes while you are actually recording.

1 Set up a value in the Quantize drop-down menu (1), which allows for the smallest note 
values you plan to play e.g. 16ths. 
(You may need to experiment with several different values to get the best result.)

2 Click the “Quantize Notes During Recording” button (2), and record as usual.

1 2

3

1
2
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How to delete recorded material

If you don’t like what you just recorded, you can either:

D Delete the notes using the eraser tool.

D Select “Undo Record Track” from the Edit menu, or

D Change the Overdub/Replace switch to “Replace” and record over the existing ma-
terial. (Remember to change it back afterwards!)

How to quantize notes after recording

If the timing of some notes still isn’t right, you can do some more quantizing. 

1 In the sequencer’s Quantize drop-down menu (1), select a value. Try 1/16 or 1/8 to start 
with.

2 Click on the sequencer track to select it.

3 Click the “Quantize Notes” button (2) – you should see the notes move slightly on the 
track. (If this sounds worse, select “Undo Quantize” from the Edit menu and try again 
with a different value.)

How to record from different places on the track

D Drag the Song Position marker to the place where you want to start recording. Then set 
up and record as usual.

How to create a group

1 Select the pencil tool, click at the start of the material you want to group and hold down 
the mouse button. 

2 Drag the mouse to the end of the material then release the button. 
(Click on the Arrow tool when you’ve finished using the pencil.)

1
2

! When creating 
groups, it is helpful to 
have the snap value 
set to “Bar”.
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How to record drum sounds in real time
In addition to creating a drum track from patterns, you can use your MIDI keyboard to trigger 
individual Redrum sounds and record these in real time, even if you already have some pat-
tern material or drum notes on the track! This might be useful if you want to add an extra fill, 
or some additional notes.

To explore the drum sounds:

1 Click on the Redrum sequencer track to select it.

2 Click the “In” column so that the MIDI icon appears.

3 Start with the key C1 on your MIDI keyboard, press the key and you should hear a drum 
sound. On Redrum you’ll see a sound channel arrow button light up. 

4 On your keyboard, work upwards by step from C1 and explore more sounds. Each drum 
sound is triggered by a specific key.

To record the drum sounds:

1 Select the Redrum sequencer track. 

2 Click the “In” column so that the MIDI icon appears.

3 Set the Song Position marker to the required starting place. 

4 If you are adding to material that is already on your Redrum track, make sure the Over-
dub/Replace switch on the Transport Panel is set to “Overdub”. 
Otherwise you erase the existing material by mistake.

5 Click Record, then Play.

6 Play your keyboard. When you’ve finished, stop recording. 
You’ll see the extra notes added to your track.
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Lesson 7: Your first original song! – Arranging 
and editing

In this lesson you are going to edit your recorded tracks and arrange them to complete your 
song!

Task 1: Editing

a. Open the file containing your own song and play the tracks you’ve recorded so far. 
• Are all the note pitches correct?
• Are any notes too long or too short?
• Do any notes still seem out of time?
• Are any individual notes too loud, or too soft?

Before you start arranging, you may need to edit some of this material.

b. Choose a track where you need to adjust some individual notes and go to the se-
quencer’s Edit view. (You need to see the Key and Velocity lanes.)

• Correct any wrong notes.

• Delete any notes you don’t want.

• Adjust the lengths of any notes that are too long, or too short. 

• Adjust the positions of individual notes that still seem “out of time”. 

• Adjust the velocity (volume) of any notes that seem too loud, or too soft.

c. Now select other tracks and edit these in the same way.

Task 2: Arranging 
Now think about how your tracks can be arranged to make a finished song.

a. Arrange the drums, bass and other tracks by moving and copying some of the material, 
so that your song has some kind of structure.

b. If you make copies of your melody or lead material, try to vary these by changing individ-
ual notes, or adding additional ones.

c. Try making some dynamic contrasts and changes in different places.

d. How about adding another track, or adding more notes to an existing track? 
Try “drawing in” notes with the pencil tool. 

! Use your “How to…” 
guide to help you edit 
and arrange your 
material.

Check out:
• How to view different 

edit lanes.
• How to adjust the size 

of edit lanes.

Check out:
• How to adjust note 

pitches or positions.
• How to adjust snap 

values.
• How to delete notes.
• How to adjust note 

lengths.
• How to adjust note ve-

locities.

Check out:
• How to create a cre-

scendo or diminu-
endo.

Check out:
• How to create notes 

manually.

! Save your work 
regularly!
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If you have some time left, try this…

A final mix
For a really professional result, do some additional work with the mixer. 

a. Can you hear all the tracks clearly, or are any too loud or too soft? 
Adjust the levels until you are happy with the result.

b. Are any sounds difficult to hear in the texture, or do any seem to stick out? 
Try adjusting the tone (EQ) controls to make them “brighter” or more “mellow”.

c. How can you position (or pan) your sounds to create some “space”?
Try placing drums and bass centrally. Arrange the other tracks to the right or left.

d. What happens to some of the sounds if you add reverb or delay? 
Try adjusting the Aux 1 and 2 controls on different mixer channels. Which sounds seem 
better with effects added and why?
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“How to…” student guide

How to view different edit lanes

1 First switch to the sequencer’s Edit view: select the track you want to view, then click on 
the button at the top left of the sequencer window (1). 

2 In Edit view, click on the icons to select the lanes you want to view - here you need the 
Key and Velocity lanes (2 and 3). 

How to adjust the size of edit lanes

1 Place the mouse over the line that separates the lanes - it will turn into a double arrow. 

2 Click on the line, hold down the mouse button and drag the line up or down until you are 
happy with the result.

How to adjust note pitches or positions

1 Click on the name of the required sequencer track to select it. 

2 Switch to the sequencer’s Edit view and click the Key icon to display the lane. 

3 In the Key lane click on the note you want to move, hold down the mouse button and 
drag the note to its new pitch or bar position. You might need to change the snap value 
in the drop-down menu in order to help you position the note accurately.

How to adjust snap values

D Click the arrow on the sequencer’s Snap drop-down menu (1) and select the smallest 
value you need in order to move a note to the required position e.g. 1/16. Also make 
sure the “Snap to Grid” button (2) is enabled. 

You should now be able to move notes just a small distance, instead of in larger steps, 
as with other previous material.

How to delete notes

In the Key lane: 

D Either, select the eraser tool and click on the note you want to delete. 

D Or, using the normal arrow tool, click on the note to select it and press the computer’s 
Backspace/Delete key.

1 2 3

1 2
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How to adjust note lengths

1 Select the note to be adjusted and you will notice a black handle appearing at the end of 
it. 

2 Place the mouse over this and it will turn into a double-headed arrow. 

3 Now click, hold down the mouse button and move the arrow left or right to shorten or 
lengthen the note.

How to adjust note velocities

1 Go to the Velocity lane for the track on which you are working, (in Edit view, click the Ve-
locity icon). 

2 Select the pencil tool and click on the note velocity bar you want to change. 

3 Hold down the mouse button and drag the pencil up or down as required to change the 
level.

How to create a crescendo or diminuendo

1 In the Velocity lane select the line tool and find the velocity bars over which you want to 
create the crescendo (the music gets louder) or diminuendo (the music gets softer).

2 To create a crescendo, click on the first velocity bar, hold down the mouse button and 
draw a diagonal line starting at value 0 and finishing at the required level on the final ve-
locity bar.

3 To create a diminuendo, click on the first velocity bar, hold down the mouse button, and 
draw a diagonal line starting at value 127 (or the highest required velocity value) and fin-
ishing at 0 on the final velocity bar of the passage.

How to create notes manually

1 In the Key lane, select the pencil tool and click at the required pitch and position. A sin-
gle click will enter a note with the length displayed in the Snap drop-down menu. 

2 To enter a longer note, click with the mouse at the required position, hold down the 
mouse button and drag to the right until you have the required note length. 
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Lesson 8: Working with loops 

In this lesson you are going to explore some loops and create some new song ideas.

Task 1: Exploring loops and slices
Open the song file “Lesson 8”.

a. Decide what style of music you are going to create and load a drum loop into the Dr Rex 
1 device. “Preview” your loop and check out the slices.

b. Change the tempo on the Transport Panel while previewing your loop. 
What happens? Select a tempo that you think sounds right for the style of your chosen 
loop.

c. Transfer your drum loop to the Dr Rex 1 sequencer track.
How can you see from the track whether this is a 1-bar or 2-bar loop?

d. Edit some of the slices. 
• Switch to Edit view and open the Rex lane.
• Click on the individual slices to hear them.
• Select and delete a few slices in bars 2 and 4.
• Move the position of one or two slices by dragging with the mouse.

e. Go back to the Arrange view. How can you see which loop repeats you’ve edited?

f. Check out some music loops and load one that matches the style of your drum loop into 
the Dr Rex 2 device. While you “preview” this loop, click the piano keys on the loop dis-
play. What happens to the music loop?

g. Transfer this loop to the Dr Rex 2 sequencer track.

h. Switch to Edit view and make one or two changes in the Rex lane. 
Try to make these changes fit musically with your drum loop.

i. Copy all the looped material – you should now have 8 bars on each track.

Task 2: Adding more ideas
Now add some ideas on other tracks to fit your looped material. Start by trying some of the 
following:

a. Record a bass line. What sounds, patterns or riffs will suit the musical style of your 
song?

b. Record some extra percussion patterns in Redrum that might sound good with the drum 
loop.

c. Explore and record some ideas for a lead line. 

! You can continue this work in the next lesson, so don’t worry if you run out of time.

! Use your “How to...” 
guide to help you 
explore and edit loops.

Check out: 
• How to load loops.
• How to “preview” 

loops and slices.

Check out: 
• How to transfer a loop 

to a sequencer track.

Check out: 
• How to audition indi-

vidual loop slices.
• How to edit loop 

slices.

Check out: 
• How to transpose a 

loop.

Check out: 
• How to edit loop 

slices.

! Save your work 
regularly!
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How to load loops

There are 2 types of loops to choose from; drum loops and music loops. Click the folder but-
ton on the Dr Rex device to go to the Patch Browser. Choose a loop either from the “Dr Rex 
Drum Loops” or “Music Loops” folders.

How to “preview” loops and slices

1 Click the Preview button (1) to listen to your loop. The loop will play at the tempo set on 
the Transport Panel. This may be different from the loop’s original tempo that you can 
see in the Dr Rex display (2)!

2 The display shows how the loop has been cut into individual slices. To see which “slice” 
is being played, activate the “Select Slice via MIDI” button (3).

How to transfer a loop to a sequencer track 

In this song file, the Left and Right Locators are already set for 4 bars of looped material to 
be transferred to your sequencer tracks. (Some loops are one bar long, while others play 
over two bars.)

! Normally you should decide where on the track you want the looped material, how many bars you 
need and set up the Locators. 

1 Select the sequencer track (1) that is connected to your Dr Rex device.

2 Click the “To Track” button on Dr Rex (2). Your loop will be transferred and will fill up the 
4 bars between the Left and Right Locators. 

How to audition individual loop slices

1 Switch to Edit view - you should see the Rex lane with the slices.
(If not, select the Rex lane by clicking on the icon.)

2 Click on the slice numbers to the left of the window. Your mouse pointer will turn into a 
speaker icon and you will hear the individual slices.

2

13

2

1
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How to edit loop slices

1 Select the track to be edited. 

2 Switch to Edit view and select the Rex lane.

3 To delete individual loop slices, select the eraser tool and click on the slice you want to 
delete. (Remember to select the arrow tool again afterwards!)

4 To move the position of a slice, click on the slice, hold down the mouse button, drag to 
the required place and release the button. 
(Note: You may need to adjust the snap value in the drop-down menu to move the slice 
precisely.)

How to transpose a loop 

While the looped material is playing, click the piano keys on the Dr Rex display (1) to trans-
pose the loop. Note: Pitch change is instant, unlike pattern changes!

• You can also transpose the loop by clicking the Transpose control (2), holding down the 
mouse button and dragging up or down. 

• The Octave control (3) lets you transpose the loop up or down one or more octaves.
• The Pitch Bend wheel (4) lets you continuously vary the amount of pitch change!

2

3

4 1
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Lesson 9: Further work with loops

In this lesson you can explore some more ideas for working with loops while developing your 
song.

Open your song file from the previous lesson and continue work.

Task 1: Ideas for extending and developing your song
Think about how to make your looped material interesting and how you can extend and de-
velop material on other tracks. Try some of these ideas:

a. Make some more copies of your drum and music loop material. Aim to have 24 - 32 bars 
altogether. You can develop this further if there’s time. 

b. Your looped tracks don’t need to play all the time. For example, try dropping the music 
loop in and out at certain places for contrast. 

c. Use Redrum patterns to reinforce the drum loop, but drop these in and out for contrast.
Which Redrum sounds fit best with your drum loop and why?

d. Create some random slices in one or two loop repeats.

e. Try applying a shuffle or groove quantize to your looped material and Redrum track.
Which setting do you prefer and why?

f. Try transposing your music loop at one or two places on the track. 
Does your music sound better with a transposition that raises, or lowers the music loop 
pitch? Why do you think this is?

g. If you’ve recorded some bass ideas using the Matrix pattern sequencer, try transposing 
these to fit with the music loop.

h. In addition to your lead line, try a second melody in places, using a contrasting sound.

i. Add some chords or a “pad” to fill any gaps in the texture.

! Important! 
Next week you will be able to play one of your own songs to other people. It might be this 
one if you’ve just finished it! Otherwise you could play your first song, or even your drum 
track arrangement from Lesson 3.

Check out these song files again, decide what you would like to play and save the file as 
requested by your teacher.

! Use your “How to…” 
guide to help you 
explore more ideas.

Check out:
• How to create random 

slices.

Check out:
• How to apply a shuffle 

or groove quantize.

Check out:
• How to record a loop 

transposition.

! Save your work 
regularly!
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How to create random slices

1 In the Rex lane, select either the entire loop, or just the slices you want to change. 
To do this, click in a space near the slices, hold down the mouse button and drag a 
frame around the slices. These will change color when selected (1).

2 From the Edit menu, select “Change Events”. 

3 In the dialog that appears, go to the Alter Notes section (2) and adjust the value to cre-
ate random variation - try 50% to start with. 

4 Click “Apply” and the selected slices will change position.
If you like, you can repeat this to achieve the result you want. Or, you can undo and try 
again with another amount.

How to apply a shuffle or groove quantize

1 Select the sequencer track to be quantized by clicking on the track name (1). 

2 In the sequencer’s Quantize drop-down menu (2), select the shuffle setting, or one of the 
groove options. 

3 Click the “Quantize Notes” button (3) to apply the groove. You might see some of the 
loop notes move slightly on the track.

1

2

1

2 3
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How to record a loop transposition

1 Set up your Dr Rex track as you normally do for recording. 
(Remember to click in the “In“ column to display the MIDI icon.) 

2 Click Record and Play.

3 Click the piano keys on the Dr Rex display to transpose the loop at appropriate places.

4 When you get to the end of the section you want to transpose, stop recording. 
Any following material will not be transposed.

Some extra information about your loop transposition will be added to the sequencer track. The 
material changes color at the places where you transposed it.

To see what you have just recorded

1 Switch to Edit view.

2 Click on the Controller icon. 

3 Click on the Show Controllers in Track icon.
This will show the lane containing your transpose information. You can see how far up or 
down your loop has been transposed.

! If you can’t remember 
how to set up for 
recording, check out 
your Lesson 3 “How 
to...” pages again.

! If you don’t like what 
you just recorded, try 
again. You can simply 
record over this 
information.
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Lesson 10: Class showcase

In this lesson, you can play some of your work to other people and listen to what they have 
done.

Task 1: Listening 
As you listen to other people’s music, use this chart to write some constructive comments 
that you can discuss afterwards.

Good Any improvements? Your reasons for this

Structure or form

Melody

Chord sequences or 
other harmonies

Use of drum patterns or 
other rhythms

Use of loops

Use of different sounds / 
timbres

Use of effects

What else did you find particularly interesting about this music?

Is there anything else that you think could have been added or changed to improve it?
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Playing your own work

When playing your work to other people, you might want to mention some of the following:

a. Whether you have worked with any particular musical style or influence in mind.

b. Which track(s) you enjoyed creating most.

c. Whether you found any tracks difficult to create and why.

Task 2: Evaluating your own work
Use this chart to evaluate the work you have done in the course so far.

What have you learned so far? How well do you think you have understood the different things?

Tick Very well Quite well Not really Comments

Arranging – moving and 
copying material

Exploring sounds

Creating patterns

Improvising 

Recording

Quantizing

Working with loops

Editing and refining your 
work

Mixing and using effects
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Lesson 11: Exploring effects – Creative use of 
reverb and delay 

In this lesson you can explore the effects units in more detail, try out different settings and 
use effects to help create more musical ideas. 

Task 1: Exploring reverb and delay 
Open the song file “Lesson 11”.

a. Solo the Melody 1 channel on the mixer and listen to the melody. (Try looping bars 1-6 
on the sequencer so that the melody will continually repeat while you work.)

b. Add some reverb. How does this change the sound?

c. Set the power switch on the reverb unit to “Off”. What happens?

d. Return the power switch to “On” and change some settings on the unit. How does this 
affect the sound? Which settings sound best and why? 

e. Now listen to this with the other channels.

f. Solo the Melody 2 channel on the mixer and listen to this melody. (Loop bars 7-11 on the 
sequencer.)

g. Add some delay. What does this do to the melody? Compare the melody with and with-
out delay by turning the power switch on the delay unit “On” or “Off”.

h. Change some settings on the unit. How does this affect the sound?

i. Listen to this with the other channels. 

j. Add reverb, delay (or both effects) to different channels until you think that the song 
sounds more interesting and musical. On each channel compare the sound with and 
without the effect.
As you add effects, think about whether the song still sounds balanced? 
You might need to adjust some mixer faders as you add more effects.

! Use your “How to...” 
guide to help you 
explore the effects 
units and create ideas.

Check out:
How to compare a 
sound with and 
without effects.

Check out:
How to change effect 
unit settings.
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Task 2: Adding effects to a drum kit

a. Add effects to individual sounds in Redrum.
• Use the S1 control to add some reverb to sound channels 2 and 3. 
• Use the S2 control to add some delay to sound channels 2 and 9.

Do any individual drum sounds seem too loud now that effects have been added? How can 
you fix this?

b. Add effects to some other drum sounds. Now listen to the drums together with the other 
sequencer tracks.

c. Now open the song file “Lesson 11a”. Listen to this and then listen to your own song 
again. 
What differences do you notice between the two versions? Which version do you prefer 
and why?

If you have some time left, try this…
In the next lesson you are going to create a short song with the title “Sporting Event”. Think 
about the following words that might describe the “mood” of this music:

• Speed
• Excitement
• Energy

a. Open a new song (select “New” from the File menu).

b. Using your MIDI keyboard, select a sound from either the Subtractor 1 or NN19 1 de-
vices. You are going to use this to improvise a main idea for your “Sporting Event” song. 
Think about the above words. Which sounds might be suitable?

c. Now think of a particular sporting event such as a football game, or motor racing. Try im-
provising a short idea, “hook” or some chords that might fit the “mood”.

d. Find the mixer channel connected to the device that is producing the sound.

e. Add some delay to the sound and play the same idea again. It may sound quite strange! 
Perhaps there are too many notes - delay needs “space” between notes to work really 
well.

f. Now try playing an idea that uses the delay effect as part of the “music”.

g. Explore different sounds and effects that you could use as a main idea for your song. 
You might want to record one or two of these ready for next time!

Check out:
• How to add effects to 

individual drum 
sounds.

! Save your work 
regularly!
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“How to…” student guide

How to change effects unit settings 

Displays for reverb types, or delay step values, can be changed by clicking on the up/down 
arrows to the right of the display.

Rotary controls can be adjusted by clicking on the control with the mouse, holding down the 
mouse button and dragging up or down to increase or decrease the setting values.

How to compare a sound with and without effects

1 Start by soloing one of the mixer channels that has either reverb or delay on it. 

2 On the appropriate effects unit, change the power switch setting to “Off”. 
You will now hear the sound without the effect. 

3 To hear the effect again, return the switch to the “On” position.

How to add effects to individual drum sounds

1 On the mixer, set the Aux 1 and Aux 2 controls on your Drums channel to 0 to remove 
any effects you have already added.

2 On the sequencer, solo the Drums track.

3 Now go to Redrum.
• Adjust the S1 control on each Redrum sound channel to add reverb. 
• Adjust the S2 control on each Redrum channel to add delay. 

4 Having added an effect, you may find that the level of a particular drum sound changes.
To balance the different drum sounds, use the Level control on the sound channels.
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Lesson 12: Exploring effects – Creative use of 
distortion
In this lesson you are going to explore the distortion unit and use different effects to help you 
create a short piece of music.

Task 1: Exploring distortion

a. Open and play the song file “Lesson 12”. (You have probably heard this music before!)

b. Solo the “Dist” mixer channel. 
Which instrument is playing? 

c. Find the distortion unit and change the power switch from “Bypass” to “On”. 
How would you describe the change to the sound?

d. Try out the different Foldback settings. Listen to each setting, first with the channel so-
loed, then with everything playing. 
Which setting gives a “sharp” distorted sound? Which setting gives a “warmer” dis-
torted sound? 

e. Try adding different amounts of distortion to the sound. 
Which settings fit the music best and why?

Task 2: “Sporting Event” song
You are going to create a short song with the title “Sporting Event”. Think about the type 
and style of music that is often played on TV sports programs. The following words might 
help you create a “mood” for your music:

• Speed
• Excitement
• Energy

a. Open your song file from the previous lesson, or create a new one (select “New” from 
the File menu). 

b. Start by setting up a rhythm track, using either (or both) of the following ideas:
• Try out the Redrum patterns that are already provided in the new song template.
• Select a Dr Rex drum loop that you think fits the mood and copy this to a sequencer track. 

c. Did you already record a main idea in the previous lesson? 
• Do the drum patterns and the loop you’ve chosen fit your recorded idea? 
• Load and preview different loops in the Dr Rex device until you find one that fits!

d. If you haven’t yet recorded a main idea:
• Using your MIDI keyboard, explore sounds from either the Subtractor 1 or NN19 1 devices that 

fit the mood you’re trying to create. 
• Add a delay effect to your chosen sound. 
• Loop the sequencer bars containing your drum material. Start the sequencer and improvise/

record a short idea over the repeating loop. Does the delay effect make it easier or more diffi-
cult to create ideas?

e. Now build up one or two more ideas on other tracks. Try adding some distortion to one 
of the sounds and see how this influences what you create! 
When you have a few ideas recorded, decide how to arrange them. What kind of sport-
ing event is your music describing? Aim to record and arrange up to 16 bars altogether.

! Use your “How to...” 
guide to help you 
connect the distortion 
unit and add different 
effects to sounds.

• If you forget how to do 
this, check out the 
Lesson 8 “How to…” 
pages.

• If you forget how to do 
this, check out the 
Lesson 6 “How to…” 
pages.

Check out:
• How to add effects 

when playing sounds.
• How to move devices 

in the rack.
• How to automatically 

connect the distortion 
unit.

• How to disconnect the 
distortion unit.
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If you have some time left…
Organize your rack and sequencer tracks! If you come back to this song in a later lesson, 
you may find it easier to remember what you’ve done if:

1 The sequencer tracks are named to show what is recorded on each track e.g. main idea, 
drum loop, or whatever names you prefer.

2 Any sequencer tracks you haven’t used are dragged to the bottom of the list.

3 Any unused sound devices are “folded” in the rack.

Check out:
• How to change the or-

der of sequencer 
tracks. 

• How to fold devices in 
the rack. 
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“How to…” student guide

How to add effects when playing sounds
Use your MIDI keyboard to choose a sound from one of the devices:

1 Click on the sequencer track belonging to the device.

2 Click the “In” column on the track to display the MIDI icon.

3 Play your keyboard to hear the sound.

D To add reverb to the sound, adjust the Aux 1 control on the mixer channel connected to 
the sound device.

D To add delay to the sound, adjust the Aux 2 control on the mixer channel connected to 
the sound device.

D To add distortion to the sound, first connect the distortion unit (see below) then use the 
controls on the unit to add the effect.

How to move devices in the rack

1 Click on the device to select it and hold down the mouse button. 

2 Drag the device to the required position in the rack and release the mouse button.

How to automatically connect the distortion unit 

1 First move the distortion unit to sit underneath the sound device to which it will be con-
nected. 

2 Click on the distortion unit again to select it. 

3 Now choose “Auto-route Device” from the Edit menu. 

4 Check out the mixer channel that was originally connected to the sound device. If the 
connection has been successful this channel will be renamed “Dist” (or “Dist Left”).
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How to disconnect the distortion unit
To undo the automatic connection you just made, select “Undo Auto–route Device” from the 
Edit menu.

If you change your mind later, decide to disconnect the unit and connect it to another de-
vice:

1 Click on the distortion unit to select it and choose “Disconnect Device” from the Edit 
menu.

You will then need to reconnect the sound device to the mixer. 

2 Click on the sound device to select it and choose “Auto-route Device” from the Edit 
menu. This will automatically reconnect it to the mixer.

3 You can now connect the distortion unit to a new sound device as before.

How to change to the order of sequencer tracks 

1 Click on the name column of the track to be moved and hold down the mouse button. 

2 Drag the track up or down to the required position, then release the mouse button.

How to fold devices in the rack
D Click on the arrow to the top left of the device.
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Lessons 13 & 14: Sound shaping and TV theme 
project 

TV Theme for “Science and Technology of the Future”

Your project
A new weekly TV series for young people “Science and Technology of the Future” needs 
some theme music. There will be 5 programs in the series:

1. “School of the Future”: about personal interactive study based at home or school.

2. “The Domestic Robot”: about revolutionizing home life by the use of domestic robots.

3. “Hospital of the Future”: about how technology could revolutionize surgery in the future.

4. “Living in Space”: about how technology could enable people to live in “space communi-
ties”.

5. “Time Travel”: about concepts of time and space.

Produce between 16 and 24 bars of music that could be used as an “intro” and “outro” for 
all the programs.

Getting started

a. Look at these key words. What kind of ideas, sounds or effects do they suggest?

b. Open the song file “Lesson 13”. This is a new song template to use for your project.

c. Some sounds are already loaded into the devices. Using your MIDI keyboard, explore the 
sounds in the Subtractor and NN19 devices. Which of the key words come to mind and 
why?

d. Try some different sounds in these devices. What other key words come to mind?

e. Experiment with some of the controls to change the character and shape of the sounds. 
Which sounds do you now prefer and why? 

f. Many TV themes are based on an idea that makes them easy to remember. Use your 
MIDI keyboard, or a Matrix pattern sequencer to build up a short “riff” or chord sequence 
that could form the main idea of your TV theme. 

g. Record this idea onto a sequencer track. (You could also create your idea by drawing 
notes with the pencil tool in the Key lane if you prefer.)

h. What kind of tempo do some of the key words suggest to you? Try playing your re-
corded idea using different tempo settings. Which tempo do you prefer and why?

Space Light Metallic Robotic

Atmosphere Distance Hollow Cosmic

Movement Energy Sharp Synthetic

Check out:
• How to adjust the con-

trols on sound de-
vices.
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Adding more material
What other tracks do you need? 

a. Look at your key words and think about some of the following ideas: synthetic bass, ro-
botic rhythms, metallic percussion, atmospheric pads.

• Explore some loops, drum sounds and bass sounds. Which of these might fit your main idea? 
• Record one or two more tracks, experimenting with sounds as before.

b. Think about how you can create “space”, “atmosphere”, “movement” or “energy”.
• Use dynamics and texture to “build” your music or create energy.
• Change the shape of sounds and record the changes to create a feeling of movement.
• Use effects to create depth and atmosphere.

c. Decide how your theme music will start, develop and end. 
• Will you create a gradual build in tension and excitement?
• Does the main idea repeat with changes in sound and texture? 
• Will you have a short intro before your main idea? Remember, you don’t have to start every 

track from the beginning.

Musical details
You want your finished TV theme to sound as professional as possible.

a. Listen to your music carefully and concentrate on the details. 
• Are there any wrong notes, uneven rhythms or individual notes that are too loud or too soft?
• Have you recorded any fader or wheel movements? Do these sound as expected when the 

music plays? If not, try editing the data in the sequencer’s Controller lane.

b. Don’t forget to do a final “mix” of the different tracks.
• Changing the character of a sound, or adding effects to it can alter its balance and tone in re-

lation to other tracks. Make some careful adjustments in your final mix to make sure that all the 
tracks are balanced and can be heard clearly.

Check out:
• How to record fader, 

wheel (or other con-
trol) movements.

• How to clear automa-
tion.

Check out:
• How to view recorded 

controller data.
• How to edit recorded 

controller data.

! Save your work 
regularly!
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“How to …” student guide

How to adjust the controls on sound devices
D To move a fader, click on it with the mouse, hold down the mouse button and drag up or 

down as required.

D To adjust a rotary control, click on it with the mouse, hold down the mouse button and 
drag up or down as required.

D To adjust pitch bend and modulation wheels, click on the wheel with the mouse, hold 
down the mouse button and drag up or down as required. Tool tips will show the amount 
of adjustment you are making on each control.

D Change display values or waveforms by clicking on the up/down arrows next to the dis-
plays.

How to record fader, wheel (or other control) movements

1 First check that the device control you want to move is set to its appropriate start value.

2 Select the sequencer track you want to record on and click the “In” column on the track 
to display the MIDI icon.

3 Set the Song Position marker to the required start position.

4 Click Record and Play. 

5 Move the device control at the required places. Stop recording when you have finished.

You will see that some additional information has been recorded onto your sequencer track. 

You will also notice that the control whose movements you just automated now has a green 
frame around it. When you play back the song, this control will automatically move at the re-
quired time.

If the result isn’t quite what you want, simply re-record your control movements.

How to clear recorded automation
If at any time you want to remove all the recorded automation for a particular device control, 
you can use the Clear Automation function:

1 Find the device control whose automation you want to cancel.
This will have a green frame around it.

2 Right-click (Windows) or Ctrl-click (Mac) on the control.

3 Select “Clear Automation” from the menu that appears.

! Note: You should 
keep recording for as 
long as you want the 
automation to take 
effect. Once you stop 
recording, the controls 
will return to their 
original settings.
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How to view recorded controller data

1 Select the sequencer track on which you have just recorded some controller data (fader 
or wheel movements).

2 Switch to Edit view.

3 Click on the Controller icon (1) and also on the “Show Controllers in Track” icon (2). 
This will display the lane(s) containing the data about the fader or wheel movements you 
just recorded. (If you record the movements of two or three controls on one device, the 
data will show up in separate lanes.)

How to edit recorded controller data
Open the Controller lane (as above) and find the lane containing the data you want to edit. 

1 Select the pencil tool and set a snap value that is small enough to let you make fine ad-
justments e.g. 1/16.

2 Click at the start of the recorded data, hold down the mouse button and drag until you 
have made your adjustment.

3 Release the mouse button.

4 If the result is not quite what you wanted, either make some more adjustments with the 
pencil, or “undo” your drawing and start again!

1 2

! You could also use the 
line tool for editing 
controller data. This 
makes it easy to create 
straight lines and 
ramps.
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Lesson 15: Creative production ideas – Mixer 
and effects unit automation 
In this lesson you are going to do some more mixing and explore some production ideas.

Task 1: Exploring some production ideas
Open the song file “Lesson 15a” and find the mixer and effects units. As you play the music, 
explore some of the following:

a. Change the power switches on the reverb and delay units to “Off” and listen to the music 
with and without the effects. How does the music sound when the effects are removed?

b. How does the music sound a) with a smaller room reverb setting and b) with a larger 
room reverb setting? Which setting do you think sounds best and why?

c. Where do you think the Dist Melody channel should be panned in relation to the rest of 
the sounds? Explore different positions for the pan control. Which one do you prefer and 
why?

d. Record a volume fade starting at bar 35. Which sequencer track will you use to do this? 

e. Solo the Dist Melody channel, find the distortion unit and explore some different settings. 
At one point in the song, switch from the distorted sound to the original sound. How can 
you make this happen automatically? Which sequencer track will you use to record the 
switch?

Task 2: A creative mix
Open the song file “Lesson 15b”. You mixed this material right at the start of the course, but 
since then you have learned a lot more “tips and tricks”! Start from scratch and create a 
brand new mix, including some of the following ideas:

a. Balance the sound levels of the different mixer channels. Should the same sounds be 
prominent all the way through, or do you need to feature different sounds at different 
times? 

b. Create a “submix” for your drums. Add effects to different sounds and try panning some 
of these to create a feeling of space.

c. Check out the other sounds. Do you think any of these could be made more interesting 
by adjusting or automating any controls on the sound devices? Which ones in particu-
lar?

d. Add some distortion to one of the sounds e.g. bass, and switch between distorted and 
clean versions of the sound during the track. 

e. Explore the EQ controls on the mixer. Which sounds can be given more “sparkle” or be 
made to sound “fuller” by adjusting the treble and/or bass EQ?

f. Try adding some reverb or delay to different sounds. Which sounds do you think are im-
proved with effects and why?

g. Experiment with panning sounds (and perhaps with automating some panning) to create 
an interesting stereo field that you think fits the style of the music. 

h. Create an ending using a “fade”.

! Use your “How to…” 
guide to help you 
create some 
interesting results!

Check out:
• How to record mixer 

automation.

Check out:
• How to record effects 

unit automation.

Check out:
• How to balance the 

sounds in your mix.

Check out:
• How to create a drums 

“submix”.

Check out:
• How to record effects 

unit automation. (If you 
forget how to connect 
the distortion unit, 
check out the How 
to…” pages for Les-
son 12.)

Check out:
• How to create a ste-

reo field.
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When you’ve finished your mix, play it through and look at the clipping indicator on the 
Transport Panel. Does it light up at any point? If so, lower the master fader slightly and play 
the same part of the song again to check that the indicator no longer lights up.

If you have some time left, try this…
D Find your “Lesson 2b” song file, open it and play your very first mix of this song. 

How do you think this sounds in comparison with the mix you’ve just done? Which ver-
sion do you prefer and why?
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“How to…” student guide

How to record mixer automation

1 Select and set up the Mixer Automation track for recording: 
• Click the “In” column to display the MIDI icon. 
• Set the Song Position marker to the place where you want to start recording. You may want to 

set this to start a couple of bars beforehand to prepare yourself. 

2 Check that the mixer control you want to move is set to the appropriate starting position. 

3 Click Record/Play and move your control at the appropriate time while the music plays. 

4 When you have finished, stop recording.
Some information will be recorded on the Mixer Automation track.

The control you just moved will have a green frame around it, showing that it has been “au-
tomated”.

How to record effects unit automation

1 Select and set up the appropriate effect automation track for recording. 
For example if you want to record adjustments to the distortion unit controls, you need to 
record this information on the Distortion Automation track. 

• Click the “In” column to display the MIDI icon. 
• Set the Song Position marker to the place where you want to start recording. You may want to 

set this to start a couple of bars beforehand to prepare yourself.

2 Check that the control you want to move has been set to the appropriate starting posi-
tion. 

3 Click Record/Play and move your control at the appropriate time while the music plays. 

4 When you have finished, stop recording.
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How to balance the sounds in your mix

1 Start by balancing your “main tracks” such as drums, bass, guitar tracks, melody etc. Try 
and set the faders for each mixer channel so that the level meters avoid going “in the 
red”.

2 While the music plays, look at the clipping indicator on the Transport Panel. If your level 
is too high at some point, the indicator will light up and remain lit for a couple of seconds. 
Try lowering the mixer’s master fader slightly until the indicator no longer lights up at the 
same point in the music.

How to create a drums “submix”
If you have created a drum track using Redrum sounds, try working on the individual sounds 
to make the most of the track.

On Redrum:

1 Balance the levels of the individual sounds using the sound channel level controls.

2 Apply reverb and delay in different amounts to individual drum sounds.

! When adding effects, solo your Drums sequencer track rather than the Drums mixer channel, 
otherwise you won’t hear the effects.

3 Use the pan control on the sound channels to create “space”. Try panning the kick 
sound centrally and the snare slightly to the right, with cymbal and other sounds panned 
left and right in varying degrees to create an interesting stereo image.

4 Now return to the main mixer and use the Redrum (Drums) channel fader to balance the 
overall level of the drums in relation to the other sounds.

How to create a stereo field
Use the pan control on the mixer channels to arrange different sounds in the “stereo field”.

• You might normally pan drums and bass to the center. However if you have both drums and a 
drum loop, you could try panning these slightly and see how they sound!

• If there is a main “melody”, decide whether this sounds better in the center, or whether it 
should be panned slightly to the left or right (this might vary depending on the style of the mu-
sic).

• Arrange other tracks such as chords, pads, rhythm guitar and some additional melodies to the 
left or right. Experiment with the pan controls to see how far left or right to place the sounds, so 
that the stereo field is musically balanced.



Lessons 16 & 17: Student party dance project

8

1

21

19

18

17

16

15

14

13

12

11

10

9

7

6

5

4

3

2

59

Lessons 16 & 17: Student party dance project

Your project
You have been asked to produce some music for a student party. You can choose to work 
in any style, but

i) your music should create a party atmosphere and make people want to dance.

ii) your music should include some of the following features:
• An intro.
• Some variation of the main idea or melody.
• Textures and ideas that “build” or create contrasts.
• Sound shaping, “sweeps” and other effects.
• An appropriate ending.

Try to produce approximately 32 bars of music. The music can be longer if you have more 
ideas!

Project introduction – Ideas! 
When composing for a particular occasion, it helps to check out some examples of similar 
music. Perhaps you have brought in a favorite CD dance or party track and are planning to 
work in the same style.

Check out how the music has been put together. 
• Listen to the musical ideas and how they are presented.
• Listen to the different sounds and how these are combined to make the music build, or to cre-

ate contrast.
• Listen for any particular effects or features that are used to create energy, excitement or move-

ment.

a. Now open and play the song file “Lesson 16a”. How has this particular party track been 
put together? (Solo the sequencer tracks to hear them individually.)

• Melody track: How would you describe this melody? How does it change during the track?
• Drums track: What are the main drum kit sounds used? How are the opening bars different 

from the rest of the track? What is used at bar 16 to lead into the following section?
• Loop track: What does the looped material do? Why do you think this is included?
• Bass track: Why do you think the bass only comes in at bar 9, instead of starting at the begin-

ning? How do the bass notes play in relation to the kick drum notes?
• What does the Strings track do? Try muting this track. Do you think the music still sounds as 

good without it? Give reasons for your answer.
• Go to the mixer. Which controls have been “automated”? What happens to the sound of the 

Melody and Synth tracks as the controls move at the start of the track? 
• Listen to the Melody again - the shape of the sound changes during the first part of the track. 

Look at the Subtractor device that plays the Melody track. What is used to change the sound 
shape and how?

b. Think of some key words that might be used to describe “party music”. One example 
might be “energy”. Write down some others and keep these in mind while working on 
your project.
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Getting started

a. Decide on the style of music you want to create.
• If you have already decided, open a new song template and check out some sounds and loops 

that fit your chosen style.
• If you’re not sure what to do, use some of the sounds from the track you’ve just played as a 

starting point. Open the song file “Lesson 16”, check out the Redrum patterns and loops and 
use your MIDI keyboard to explore sounds in the other devices.

b. Choose a suitable tempo for your track. If you decide to work with loops, check how they 
sound played at your chosen tempo, especially if this is different from the loop’s original 
tempo.

c. Decide which part of the track to work on first.
• You may find it easier to create your ”main idea” first. You can always work on extending this, 

and on creating other sections later.

Developing ideas

a. Group your “main idea” material and make one or two copies. How can you create some 
variation in repeated phrases and sections?

• Try dropping out some sounds. 
• Adjust or remove some notes, for example in the melody.
• Try adding another loop in places. Use your MIDI keyboard to record “trigger” notes. 

b. Work on the structure of the track. Add an intro and perhaps a contrasting section at a 
suitable place, then think about what material you want to use for your ending.

• Create groups to show different song sections or repeats. You don’t have to copy a whole 
group or phrase every time - you could just copy part of a group.

• You can always add a new section in the middle of existing material by inserting empty bars.

c. As well as building up and breaking down textures, how else can you create a feeling of 
excitement and movement?

• Changing pitch can create excitement. Try transposing music loops, or melody and bass pat-
terns in upward steps. Use pitch bend on one or two sounds.

• Change the “shape” of sounds by adjusting and automating the sound device controls.

• Move sounds from one side of the stereo field to the other by “sweeping” the pan controls on 
the mixer channels.

• Add effects to different sounds. You might even want to alter the amount of reverb or delay 
added to a particular sound as the track progresses. 

d. When you have completed your music:
• Listen carefully to the balance of the sounds.
• Check your effects. Is there too much reverb, delay or distortion anywhere?
• Do all the controls that you’ve automated move at the right time?

Check out:
• How to trigger and 

record loops in real 
time.

• How to “draw in” loop 
trigger notes.

Check out:
• How to create groups.
• How to divide a group.
• How to insert extra 

bars.

! If you forget how to do 
this, check out the 
“How to…” pages for 
Lessons 5 and 9.

! If you forget how to do 
this, check out the 
“How to…” pages for 
Lessons 13 and 14.

! If you forget how to do 
this, check out the 
“How to…” pages for 
Lesson 15.
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“How to…” student guide

How to trigger and record loops in real time

1 Load a loop into one of the Dr Rex loop players.

2 Click the “In” column of the connected sequencer track to display the MIDI icon. 

3 Play the D0 key on your keyboard and you should hear the loop play. 

To record the “trigger notes”

1 Set up your selected Dr Rex track for recording as usual. 

2 Click Record and Play. 

3 Play the D0 key at the places where you want the loop to play. Stop recording when 
you’ve finished. 

4 Play the song again and the loop should play at the points where you recorded the 
notes.

How to “draw in” loop trigger notes

1 Select your Dr Rex track, switch to Edit view and click the Key icon.

2 Select the pencil tool and find the note pitch D0 (use the keyboard at the side to help 
you).

3 Draw in a D0 note. In general, whatever length of note you draw (even a 1/16 value) will 
trigger the whole loop. Check out the length of the loop you plan to use so that you don’t 
trigger a new loop repeat before the current one has finished (unless you want this effect 
of course).

How to insert extra bars

1 Using the Left and Right Locators, set up the start and end points of the section in which 
you want the empty bars to appear. 

2 Click somewhere in the main sequencer area.

3 Choose “Insert Bars Between Locators” from the Edit menu. You should now see some 
empty bars between the Locators. The other material shifts position to allow for these ex-
tra bars.

! Note: You may need 
to change the octave 
setting on your 
keyboard in order to 
reach the D0 key.
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How to create groups

1 Select the material you want to group: click in a space near the material, hold down the 
mouse button, draw a frame around the material to be selected then release the mouse 
button.

2 Select “Group” from the Edit menu. All the individual groups on each selected track will 
now appear as single units. You can then drag or copy this selected material to another 
position in your song.

How to divide a group
This lets you split a group so that you can just move or copy the bars that you actually want.

1 Select the pencil tool and click at the place where you would like to make the split. 

2 Hold down the mouse button, drag to the right until you reach the end of the group then 
release the button. You should now have two separate groups.
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Lessons 18 & 19: “Variations” project

Your project
You have been given a short musical idea, or “theme”. It has a melody, a bass, a drum track, 
some looped drum material, a music loop and a chord track.

Your task is to create 3 “variations” on this theme. In each case you can copy and use some 
of the material from the theme, but you also need to make changes to this, so that there are 
noticeable differences in each of your variations.

Getting started

a. Open the song file “Lesson 18” and start by checking out the main theme. 
• How could you describe the structure of the music? 
• What musical device is used during the first 8 bars?

b. Listen to each track individually. Now listen to different track combinations, for example 
drums, bass and chords, or bass, chords and music loop.

c. Check out some other material you have available.
• Check out the loops in the Dr Rex devices (click Preview). Are the original loops used in the 

main theme, or have these already been edited?
• The drum track has been recorded using a MIDI keyboard to play the Redrum sounds. Go to 

Redrum and you’ll find some other patterns that you could use in your variations. Check these 
out.

• Mute the Drums sequencer track, then play the music and try out some of the different Redrum 
patterns instead. 

By exploring this main theme, you have already found some ways of creating “variation”:

i) varying textures and sounds.

ii) varying rhythms by using different drum patterns.

Your first variation

a. Make a copy of the main theme material. 

b. If you’re stuck for ideas, start by varying the melody. There are several different things 
you could do! Try one of the following ideas:

• Change the pitch of some of the melody notes. 
• Add some extra notes by drawing these in with the pencil tool.
• Move the melody to the empty NN19 track, and choose a different sound to play it.
• Copy the melody to the empty NN19 track and let it start half a bar later than the original. You 

might need to alter or delete one or two notes in the Key lane so that this new melody fits per-
fectly with the harmonies.

• Delete the melody altogether. Use your MIDI keyboard to improvise and record a new one over 
the existing rhythm, chords and bass.

! To do this, you need to 
click on Redrum's 
Pattern button to hear 
pattern playback.
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More variation ideas
When you’ve done some work on your first variation, start to think about what you can do in 
your next one. You can always go back and do more work on each variation later.

a. Make another copy of the original theme as a starting point for your second variation. 

b. In each variation you might decide to concentrate on one or two particular musical as-
pects. In addition to the previous ideas, try some of the following:

• Make the bass track more elaborate by adding extra notes.

• Replace some or all of the original drum track with other Redrum patterns. (Copy these pat-
terns to the Drums track using “Copy Pattern to Track”.)

• Edit looped material by deleting slices, or creating random playback of some slices. 

• Record individual loop slices using a MIDI keyboard and creating your own rhythms.

• Keep the original melody and rhythm tracks, but improvise and record new bass and chord 
tracks to create some harmonic variation.

c. In addition to varying rhythm, melody, harmony and texture, try changing the shape of 
sounds, adding effects or using dynamics.

• Add some delay to the melody, or perhaps to the loops. How can you arrange for the delay ef-
fect to be automatically applied to a sound in just one of the variations?

• Use some pitch bend on the melody or bass in one of the variations. 

• Explore some other ways that you could change the shape or position of sounds during one of 
the variations.

• Make some dynamic contrasts by changing note velocities, or by creating a crescendo or di-
minuendo at one point.

Finishing touches
Create a final mix of your complete theme and variations.

• Are all the sounds balanced? Does the balance of the tracks stay the same throughout, or do 
you need to adjust the positions of any mixer faders for different variations? How can you make 
this happen automatically?

• Add any general EQ and effects such as reverb. 

• Pan the tracks to create a musical stereo field. (If you want to change the position of a particu-
lar sound in one variation, you can “automate” the pan control on the appropriate mixer chan-
nel.)

! If you forget how to do 
this, check out the 
“How to…” pages for 
Lesson 5.

! If you forget how to do 
this, check out the 
“How to…” pages for 
Lesson 9.

Check out:
• How to play and 

record individual loop 
slices.

! If you forget how to do 
this, check out the 
“How to…” pages for 
Lessons 15.

! If you forget how to do 
this, check out the 
“How to…” pages for 
Lessons 13 and 14.
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“How to…” student guide

How to play and record individual loop slices via MIDI keyboard
You can use different keys on your MIDI keyboard to “trigger” individual loop slices.

To play the slices:

1 Load a loop into one of the Dr Rex devices.

2 Select the sequencer track that is connected to the device and click the “In” column to 
display the MIDI icon.

3 Play the key C1 on your keyboard and you should hear the first slice. If you activate the 
“Select slice via MIDI” button on the Dr Rex device, the individual slices will be selected 
in the loop display as you play different keys.

4 Work up the keyboard by step and check out the slices. Then explore the slices in a dif-
ferent order!

To record the slices:

1 Set up the appropriate Dr Rex sequencer track for recording as usual.

2 Click Record/Play and record your slices. When you’ve finished, stop recording.

3 You will now see the individual slice “notes” on the track. These can be edited in either 
the Key or Rex lanes.
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Lesson 20: Editing project and assessment

In this lesson you are going to do some editing. See what you can remember from the previ-
ous lessons!

Start by opening and playing the song file “Lesson 20”. As the music plays, have a look at 
the following tasks. Complete as many as you can - you can try them in any order. If you 
can’t remember what to do, have a look at the clues! 

As you begin to edit the file, don’t forget to save your work regularly!

Your tasks:

1 The song starts with a solo instrument. How can you make a crescendo over the open-
ing bars?

2 Listen carefully to the rhythm of the drum track in relation to the other tracks. 
What seems to be the problem? How can you fix this?

3 The snare drum is a bit too loud in the mix. 
How can you adjust its volume (or level) without changing the level of the other drum kit 
sounds?

• How will a crescendo 
affect the notes? Will 
it alter the pitch, 
rhythm or velocity (vol-
ume)?

• Which sequencer edit 
lane will you use for 
creating your cre-
scendo?

• Which tool will help 
you create a cre-
scendo quickly?

• Your clue to this ques-
tion lies in using 
“Quantize”. Can you 
remember what this 
does?

• The main mixer is not 
the answer this time! 

• Which device is used 
for playing the drum 
track?

• How can you adjust 
the levels of the differ-
ent drum sounds 
here?
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4 Listen to the bass track and find the device that plays the sound.

How could you improve or modify the sound to give this bass line more “power”? 
(Try 2 different ideas.)

5 The looped tracks repeat throughout the song. 
How could you create some variation?

6 What do you notice about the lead line? 
How could you create some variation here?

7 The song needs to fade out over the final bars. 
How can you arrange this so that the fade will be automatic each time the song is 
played?

If you have a class discussion afterwards, think about the following:

D Which tasks do you think you completed most successfully and why? 

D Are there any tasks you found particularly difficult, or think could have been improved? 
What improvements would you like to make next time?

• How could you alter 
the “shape” of the 
sound using the de-
vice front panel con-
trols?

• If you move or 
“sweep” some filters, 
or use pitch bend, how 
can you get the con-
trols to automatically 
repeat the movements 
during playback?

• What about adding 
some distortion? 

• Here you will probably 
work in the Key lane. 
Think about changes 
of pitch and about 
adding or deleting 
notes.

• Which mixer fader will 
let you change the 
level of all the tracks at 
once?

• Think about how you 
can record the move-
ments of the mixer 
fader you have used. 
Which sequencer 
track should you use 
to record this informa-
tion?



Lesson 21: Preparing a coursework portfolio

8

1

21

19

18

17

16

15

14

13

12

11

10

9

7

6

5

4

3

2

69

Lesson 21: Preparing a coursework portfolio 

In this lesson you can prepare some, or all of your songs for transferring to audio CD. 

Task 1: Selecting songs for your CD
Start by selecting the songs you would like to include on your CD.

a. Listen carefully to each song. 

b. Does each song still sound as good as it did a few weeks ago? 
• Have you now noticed any mistakes?
• Are there any small improvements you want to make?
• Did you originally have time to mix the song properly? Is there anything you want to change 

now?

c. Make any small adjustments or improvements to your song files.

d. When you have finished working on each song file, listen to it again and check the levels 
carefully. 

Task 2: Preparing and exporting your song files

a. Decide whether you want to put the whole song file on CD, or just a section. 
It could be that one of your songs has a great beginning, but you don’t much like the end 
for example!

b. Listen carefully to the ending of each song. Did you use any effects?
If so there might be a small “trail” right at the end. Be careful not to cut this off when you 
set your ending marker, otherwise the song might end a bit abruptly.

c. Export your song, or song section.

d. Repeat these steps until you have exported all the songs you plan to include on your CD.

When you are ready to produce your CD:
Think about the order in which to arrange the tracks. They don’t need to be arranged in the 
order that they were created. Try and arrange them so that you have some contrasts of style 
and tempo. 

! Use your “How to ..” 
guide to help you 
prepare and export 
your song files.

Check out:
• How to check your fi-

nal song levels.

Check out:
• How to prepare your 

song file for export.

Check out:
• How to export your 

song as an audio file.
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“How to…” student guide

How to check your final song levels

If you have made any changes to your song, the levels of some tracks, or even the whole 
song might have changed. It is important that your levels are not too high, otherwise you may 
find some distortion on your final CD.

1 Play your song all the way through and watch the clipping indicator on the Transport 
Panel. If this lights up, (or the meters on the hardware interface go “in the red”), you may 
need to make some adjustments. 

2 Check the master fader level and reduce it slightly until the clipping indicator no longer 
lights up.

How to prepare your song file for export

If you plan to export the whole song:

1 Scroll to the end of the file and find the E (End) marker.

2 Drag this to the end of the song. 

3 If you have used effects such as reverb and delay, listen in case there is an “effect trail” 
at the end of the song. Place the E marker at the end of this trail – this will probably be a 
bar or so after the end of the actual material. If you simply place the marker at the very 
end of the material, you might cut off the trail and make the song ending sound rather 
abrupt. To help you hear the effect trail, increase the volume and listen carefully to the 
very end of the song.

If you plan to export just part of the song: 

D Set the Left and Right Locators to the start and end of the section you want to export.
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How to export your song as an audio file

If you are exporting the whole song:

1 Select “Export Song as Audio File” from the File menu.

2 In the dialog box that appears, choose a name for the file and a location on your hard 
disk where the file should be placed. 

3 Select the file format required for your CD recording software. (If you are not sure, check 
with your teacher.)

4 In the next dialog, select 16 for the bit depth and 44100 (44.1kHz) for the sample rate. 

5 Click “OK” (Windows) or “Export” (Mac). In a few seconds the new file will appear on 
your hard disk at the chosen location.

If you are just exporting part of a song:

1 Select “Export Loop as Audio File” from the File menu.

2 Complete the other steps as before.
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